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muvee autoProducer

muvee autoProducer is an award winning application that you can use to create

really professional looking music videos instantly.

All you have to do is select your movie or pictures, add a soundtrack, select a

ready-made style, and click make muvee.

System Requirements

The following system requirements must be met to ensure correct operation of

muvee autoProducer.

• Operating system: Windows XP, 2000, ME, or 98SE

• CPU: 1 GHz Pentium III, AMD Athlon or equivalent CPU with MMX support

• Memory: 256 MB

• Video memory: 16 MB

• Other software: DirectX 9.0

Note:

Apple QuickTime is required for .3gp and .mov format support.
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Installation

Insert the Handset Manager CD into the

CD-ROM; the installation window

appears. Click the muvee autoProducer

button to begin the installation.

Getting Started

Start muvee autoProducer from the Start menu:

Start > Programs > muvee Technologies > muvee autoProducer 4.1 -

AsusTek > muvee autoProducer 4.1 - AsusTek

ASUS Muvee autoProducer supports the following input formats:

• Video files: MPEG-1, MPEG-4, AVI, WMV, MOV, and 3GPP (3GP)

• Pictures: JPEG (JPG), BMP, GIF, and TIFF

• Audio files: MP3, WAV, and WMA
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Making Your First muvee

1. Click the Add Video/Pictures button to browse your hard disk (or

handset connected to your computer) for movies and pictures* to

include in your production. You can also get footage directly from a DV

camera if you have a suitable capture card.

2. Click the Add Music button to browse for audio files* on your hard

disk.
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3. Click a style to select it. A sample of the style is displayed in the in the

preview window.

When your muvee is complete, it is displayed in the preview window.

*  See page 2 for more details about file formats supported.

4. Use the Rotate Pictures button to rotate your images.

5. Use the Magic Moments button to select important moments in your

video to ensure that they are included in the final production.

6. Use the Change Settings button to change your settings.

7. Use the Title/Credits button to set the title and credits for your muvee.

8. When your movie contents are complete, make your muvee using the

Make muvee button.

9. Save your muvee using the Save button.

10. Use the Snapshot button to take a snapshot of any frame in your

muvee as it is playing.

 You can save your muvee in MPEG-1, WMV, or 3GPP (3GP) formats. Save the

 file in WMV or 3GPP format for downloading your muvee to your handset. Asus

 Handset Manager is required to download your muvee to your handset.

 For more information, click the Help Menu in muvee autoProducer.

 Downloading a muvee to the Handset

 A saved muvee can be transferred to your handset and played on the screen. A

 large muvee file may take a while to transfer.
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To download a muvee to your handset:

1. Save your muvee on your hard disk on your computer.

2. Launch Handset Manager and click the VIDEO EDITOR icon (ensure

that your handset is connected to your computer).

3. In the video editor menu click the BROWSE FILE icon and find the

location of your saved muvee file (your muvee file should now be

displayed in the file window).

4. Click on the DOWNLOAD icon.

Your handset manager will now begin to convert your muvee file and

download it into your handset (the file will be saved into folder labelled

"Video" either in your handset internal memory or memory card

depending on which has been selected).
Update to

handset

muvee file

Browse
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Handset Manager
The Handset Manager is a powerful software tool to link your mobile phone and

your computer. Use the Handset Manager to send files from your computer to

your phone, including music, ringtones, pictures, and java games.  Stay orga-

nized by managing and synchronizing your phone’s contacts and calendar with

your computer. Compose text and multimedia messages quickly and comfort-

ably on your computer, then transfer them to your phone to send.

This user guide gives an introduction to basic functions of the Handset

Manager. For additional information, consult the online help files included with

the Handset Manager.

Installing the Handset Manager

Ensure that the following system requirements are met:

Software:

• Windows 98 or above operating system

Hardware:

• USB 2.0 port

• CD-ROM drive
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To install the Handset Manager software:

1. Insert the software CD into your computer to start installation.

2. On the start-up page, select the mobile phone model and interface

you wish to install.

3. Turn on the phone and connect it to the computer using the supplied

USB cable.

When you turn on the phone, the phone prompts you to select a type

of USB connection. Select COM Port.

4. Click OK on the phone keypad to proceed.

5. Click Install Handset Manager.

Notes:

�  Make sure the mobile phone is switched on and correctly connected with the USB

data cable before installation.

�  Most systems already support USB. However, if your system does not, install a

USB driver before installing the Handset Manager software.

�  To uninstall software, click the Add/Remove Programs icon in the control panel.

Select the Asus V66 USB-Handset Manager from the list. Click the Remove

button and follow the instructions on screen.
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Starting the Handset Manager

To start the Handset Manager:

1. Connect your handset to a USB port on your computer using the

supplied USB data cable, then turn on your handset.

2. A list of connection types appears in the handset window. Select COM

Port.

3. Select Asus V66 USB—Handset Manager>Asus V66 USB—

Handset Manager from the computer’s program list, OR

Right click the  phone icon in the system tray in the lower right

corner of the screen. Select Handset Manager.

4. An animation in the Handset Manager main panel shows your connec-

tion status.

Notes:

�  Be sure to unplug the USB cable after use. The computer may not boot as usual if

you start the computer with the phone’s USB cable connected.

�  When disconnecting the mobile phone from the computer while using Handset

Manager, first turn off the handset, then disconnect the USB cable. When

transmitting data to the Handset Manager, don’t disconnect the handset.

�  While transmitting and editing data, don’t operate the phone and Handset Manager

at the same time.

�  Don’t install Java Games through Handset Manager while simultaneously playing

Java games in the mobile phone
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Main Panel

The following illustration

shows the main panel. Access

all the Handset Manager

functions from this Panel.

Access the Handset Manager

tools by clicking on the icons

at  the bottom of the screen.

Each tool has its own

interface, which opens when

you click on the icon. This user

manual contains a chapter for each of these tools.

 Phonebook  Message  Album  MMS  File Manager  Video  Sound

Clicking the  three buttons in the upper right corner of the main Handset Man-

ager panel does the following:

  Closes Handset Manager and minimizes the system tray.

  Minimizes Handset Manager to the task bar.

  Opens online help and settings.
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Settings, Information, and Online Help

You can access several items related to settings, information, and online help

by clicking on the  icon.

• Select Help Topics to open online help. You can also open online

help from the program list: Asus V66 USB—Handset Manager>

User’s Guide.

• Under Settings, you can select whether to run the Handset Manager

automatically when you start the computer. You can also set the

computer port, handset model, and interface type manually here.

• Select Handset Version to see the model name and firmware version

of the phone, when the phone is connected. Select About Handset

Manager to see the version of Handset Manager installed in your

computer.

Navigating the Handset Manager Tools

No matter which Handset Manager tool you are working with, you can access

functions and commands in the following three ways. The Messages window is

shown as an example.

1. Right-click to bring up the pop-up menu or click icons on the menu

toolbar, OR

2. Click on the  File button in the upper left corner to choose from a

drop-down menu, OR

3. Click on the icons in the upper right of the window.
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When you move the mouse over an

icon, a pop-up window tells you the

name of the button.

Note:

You must exit one tool before launching

another.

Navigating Media Files

The interfaces for media tools—MMS, Sound, or Album and Video —are quite

similar. The Album interface is shown here.

File path /

browse icon

Thumbnails of

computer filesPhone  files

Icons for functions

Preview pane

Album Window

Phonefile

location

Messages Window

File button Icons for functions
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• The left preview pane shows a preview of the files you select. A drop-

down menu on the left lets you select the location of phone files.

Select Handset or Memory Card.

• Thumbnails of files in the phone are shown in the lower left pane.

• Icons in the upper right corner give access to various functions, such

as copy, paste, and delete. Also in the upper right, a frame shows the

current file path, next to the   browse icon. If you want to choose

another file location, click this icon. The browse icon and drop down

menus give you access to computer files only.

• Thumbnail views of computer files in the selected location are shown

in the lower right pane.

Transferring Files to and from the Handset

• To edit a file in your handset, download the file to your computer by

clicking on the  Download icon in the upper right. The download

function does not save the file on your computer. To save the file on

your computer you first download it as described above and then

right-click and select Save from the dropdown menu. You can then

save the file to a specific location on your hard disk.

• To add a file to the handset,  click on the  Update icon.

• To refresh the folder display click the refresh icon .

Notes:
�  As used in the Handset Manager software, the term update has the same meaning

as upload.

�  You do not necessarily need to select a folder on the phone’s handset or miniSD

card. The Handset Manager automatically locates the appropriate folder for the file

type.
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Handset Manager Folder Location

The Handset Manager creates a default folder in the My Documents folder in

Windows. Find this folder in My Documents > Mobile Action > Handset

Manager. There are also sub-folders for the different types of files you can work

with in the Handset Manager.

Note:

To locate handset files using the handset screen, go to Organizer > File Manager.

Handset Manager Icon

A Handset Manager icon appears in the system tray, even when the Handset

Manager is minimized. By right-clicking  the Handset Manager icon in the

system tray, you can select the following Handset Manager functions: Handset

Manager, SyncManager, SyncManager Settings, and Exit.

The appearance of the icon in the system tray indicates the current status:

 Handset Manager is connected with the handset.

 SyncManager has launched auto-synchronization.

 The handset is disconnected from Handset Manager.

Note:

When you close the Handset Manager window, the application remains running in the

background. To completely exit Handset Manager, right click and select Exit .
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Phonebook
Organize and keep contacts up to date by using your computer to coordinate

and manage the information in your phone. You can coordinate your information

even further by exchanging contact information between your phone and the

Windows e-mail or information management programs such as Microsoft

Outlook or Outlook Express.

Downloading Contact Information

When you open the Phonebook tool, the contact entries in your phone are

automatically downloaded and displayed in the Contacts window.

Note:

If the contact entries have previously been downloaded, then a prompt will be

displayed before downloading contact entries.

Click OK to download entries from your phone for editing. Click Cancel to view

the previous contact entries, but editing function will be unavailable.

File button Icons for functions

Contact

entries

Contacts Window
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To download contact information from the phone to the computer:

1. Select a phone location from the dropdown menu. Select Handset or

Memory card, depending on where your contact information is stored.

2. Click the  Download icon. The contacts are then downloaded to the

computer.

A message appears to tell you if the transfer was successful or

unsuccessful.

Editing New Contact Entries

Adding a New Contact Entry

1. Click on the  New icon, OR

Right click anywhere in the entry area and select New Contact Entry.

2. An Edit Contact Entry window appears. Select whether the contact will

be saved to the handset or the SIM card, and enter information into

the information fields.

Editing a Contact Entry

1. Click a contact entry. The selected entry is highlighted.

2. Click the  Edit icon, OR

Right click and select Edit Contact Entry.

3. An Edit Contact Entry window appears. Change the storage location

or enter new information in the fields, then click OK to save.
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Updating Contact Information to the Phone

When you add or edit contact entries in the Phonebook tool, the information is

stored in your computer. To store the information in your phone, you must use

the Update function.

To update contact information to your phone:

1. Click on the  Update to handset icon.

2. A Confirm Updates in Contacts window appears to show any

differences between information in the phone and the Handset

Manager.

Icons mark contact entries as unchanged, added, modified, or

removed.

Click OK to proceed with the Update.

Note:

The storage location for contact entries is set individually. To modify a storage location,

follow the steps described above in Edit Contact Entry.

Exporting and Importing Contacts Data

Exporting Contacts from the Phonebook

1. Select  File> Export.

2. Select either Comma Separated Value (.csv) File or Text File from

the drop-down box.

3. A Save As window appears.

In the File Name frame, an asterisk appears before the file type.

Substitute a file name for the asterisk.
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For example, you could change *.csv to MyContacts.csv.

4. Select a location from the Save in:  drop-down box.

5. Make sure Export Contacts from the Contacts folder is the action

to be performed.

Note:
For details about which file type to export, or how to import the .txt or .csv file into

Microsoft Outlook Express, or other e-mail or information management software, refer

to the help or user manual for the software.

Importing Contacts to the Phonebook

You can also import contact entries from e-mail or information management

software, such as Microsoft Outlook Express.

To import contacts:

1. Select File > Import. An Open dialog box appears. Select a location

using the drop-down box. Click the .csv file you would like to import,

then click Open.

2. A Choose Fields to Import box appears.

The column on the right shows available contact information fields in

the .csv file.

The column on the right shows available contact information fields in

the Handset Manager.

Fields in the .csv file may not correspond to fields in the Handset

Manager because of different names for items, or because of different

types of information. If fields do not correspond, (Not Used) appears

in the column on the right.
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To import the information for a non-corresponding field, you need to

assign it to one of the fields in Handset Manager. This is called

mapping.

3. To map a field, click the field to select it, then click the Map button.

4. A drop-down list of Handset Manager fields appears. Select the

desired Handset Manager fields, then click OK.

5. If all desired fields are mapped, click OK to import the contact infor-

mation into Handset Manager.

The new contact entries then appear in the Contacts window.

Backing up Phonebook Data

To save a contacts backup file:

1. Click on the File icon, then select Save As.

A Save As dialog box appears.

2. Enter a file name and select a location. The contacts file extension

type is .pbf.

3. Click on the Save button to save the file.

Note:
If you are using Microsoft Outlook or Outlook Express, and you do not need to edit

contact entries or manage contact fields, you may choose to automatically synchronize

contact or calendar information using the SyncManager. See the SyncManager chapter

of this manual for more information.
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File button Icons for functions

Local

folders

Messages in

selected folder

Selected message

Handset

folders

Messages Window

Messages
With the handset manager, you can comfortably create SMS messages on your

computer, then export the messages to your phone using the Messages tool.

The Messages interface is much like a standard e-mail program, with folders for

the handset and local (computer) drive. You can also create personal folders

and categorize your messages so that your messages are easily accessible and

well-organized.

Downloading Messages

The phone automatically coordinates message files between the phone and the

computer, so you do not need to individually select files for downloading and

updating.
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When you click  Download, the message folders on the computer are updated

to match those on your phone.

Composing  a  message

1. Click  Create to compose a new SMS and open a new message

window.

2. Enter the message text.

3. Click  Smileys to enter Smileys.

4. Click  Insert Object. A pop-up box appears to select Insert Object,

Insert MIDI, or Insert Animation.

5. After composing the message, specify the recipient. Type a mobile

phone number, or click the TO: button to select recipients from the

phonebook.

6. Click  Save Message to save the message.

A dialog box appears for you to choose a folder to save to on the

computer.

Note:

SMS messages can only send black and white pictures in .ems format. When you

insert a picture into an SMS, Handset Manager automatically converts the file into a

black and white .ems file. You can also create and edit your own .eps files with the

Handset Manger Album tool. See the section “EMS Images” in the Album chapter of

this manual for more information.
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Updating and Sending Messages to the Handset

After composing a message and saving it in a mail folder on your computer, you

can update the file to your handset to send it.

To send a message:

From the main Message window, click   Send Outbox Message.  Unsent

messages are then updated to the handset.

Right-click on any sent message, and choose Details to see its delivery status.

If any problem has occurred, you can choose to resend to all of the recipients or

resend unsent messages.

Note:

�  Use Upload and Download functions to conduct the SMS synchronization.

�  Store the SMS messages in any folder in the Local Folder. Messages to be moved

to the mobile phone should be placed in the Unsent folder.

�  Use Insert Objects to add the MIDI ring tones or animations to the message.

�  If you have performed phonebook download, when editing the message, you can

click Receiver to send the message directly by selecting the names.

�  The EMS pictures in My Album can be inserted. Refer to the instruction in the

section titled "My Album".

�  This mobile phone supports EMS messages. However, pictures, MIDI or anima-

tions added in the message may not be displayed properly on devices that do not

support EMS messages.
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Album
The Album tool enables you to create images on a PC and transfer images

between your phone and computer. To help you get started, the Picture Editor

has a  library of clip art, frames, and masks. You can also easily design frame-

by-frame animations using Animation Composer.

Album contains icons in the upper right corner to help you manage, edit, and

create images.

Downloading Pictures to Computer
1. Select a phone location from the drop-down menu. Select Handset or

Memory card. The picture files in that location then appear.

2. Click an individual picture file to select it.

3. Click the   Download icon, OR

Right click and select Download.

Thumbnails

of computer

files
Phone  files

Preview

 Window

Phone file

location

Tabs

Album Window



23

H
 a n d s e t   M

 a n a g e r
A dialog box appears.

4. Click OK.

The file is then transferred to the computer.

A message appears to tell you if the transfer was successful or

unsuccessful.

Notes:
�  Pictures need to be downloaded to the computer before you can edit them.

�  If you would like to view newly added picture files, you may need to refresh the

folder view by clicking the  Refresh icon.

�  The following picture file formats can be transferred between the phone and the

computer: bmp, jpg, ems, gif.

Editing and Creating Pictures

You can edit images or create new images using the  Picture Editor window. You

can cut and paste, add text and drawing, remove background, or  rotate images.

PIcture Editor Window

Thumbnails

of computer

files

Image

Folder,

Library,

Effects tabs

Selection area

Zoom, picture

size, color

type
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To edit a picture:

1. From the main Album window, select a picture file, then double click

the file or click   Edit to open it.

2. The Picture Editor window opens.

When you open an picture, a selection frame also appears. Click the

selection frame to make it active, then resize as needed.

3. Click various icons to add text, rotate the image, add a mask, or draw

with the pencil tool.

4. Click the image folder tab above the pane on the left to view pictures.

You can then drag and drop these pictures onto your working space.

Clicking the second tab, the Library tab, gives you access to clip art,

frames, and masks.

Clicking the third tab, the Effects tab, enables you to edit color,

brightness, contrast, sharpness, and transparency.

5. When you have finished editing your picture, click   Save to save the

file to the computer.

To create a picture:

1. From the main album window, click  New Picture. The Picture Editor

then opens with a blank working space.

2. Drag and drop images from the pane on the left, draw, or add text or

effects as described above in the steps for editing a picture.

EMS Images

The main Album window contains a tab called EMS. EMS pictures are black

and white pictures that can be included in SMS (text) messages.
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Select the EMS tab and click on  New Picture, the Image Editor opens, with

an interface and tools for drawing new EMS images.

Updating Pictures to the Phone
1. Click an individual computer picture file to select it.

2. Select a phone file location from the drop-down menu. Select Handset

or Memory Card. The picture file will be transferred  to a folder called

“Image”.

3. Click the  Update icon. An Update dialog box appears. Click OK.

The file is then transferred to the handset.

A message tells you if the transfer was successful or unsuccessful.

Creating Animations

Animations are composed by placing two or more still frames. After placing

frames, you can create transition effects and edit timing.

To create an animation:

1. Click   New Animation. The Animation Composer window opens.

2. If you drag an image from the pane on the left, a frame is automati-

cally created. You can also click  New Frame to add a new frame.

3. Click the Transition Effect tab to add transition effects  such as Blinds

or Wipe.

4. After placing two or more frames, click  Playback to preview the

animation.

5. Click  to save in the computer.



26

®

MMS
Messages can be creative and fun when you add pictures, sounds, or video.

The Handset Manager expands the possibilities for multimedia messages by

putting the resources of your computer at your fingertips.

Viewing MMS

From the main MMS window, you can see MMS messages in the computer and

the phone.

Icons for

functions

Preview

pane

Handset /

memory

card pane

MMS

thumbnails

MMS  Window



27

H
 a n d s e t   M

 a n a g e r
Above the handset / memory card pane is a drop down box to select MMS

folders. Select Inbox, Outbox, Templates, or Saved Items.

Note:

Handset or memory card MMS files must be downloaded to the computer before you

can open them for viewing or editing.

Downloading MMS

You can easily coordinate and transfer MMS messages between your phone

and computer.

When you click  Download, the MMS message folders on the computer are

updated to match those on your phone. A message appears to tell you if the

transfer was successful or unsuccessful.

Composing or Editing an MMS

You can edit an MMS or compose a new MMS in the MMS Composer Window.

On the left of the MMS Composer interface is a preview pane. This preview

pane has three tabs. Click on the Image or Audio tabs to preview picture and

audio files.

To play an MMS, select the  Play tab in the upper left, then click the Play button.

On the right is a time line. This is where the slides are placed as you compose

an MMS. Use the icons in the upper right to compose and edit slides.
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To compose or edit a new MMS:

1. In the main MMS window, open an existing MMS by double clicking it,

OR

Click the  New icon. The MMS Composer window opens.

2. Click  Add New Slide. A blank slide appears.

3. Click various icons to add text, pictures, or sound.

For example, to add a picture with text underneath, click  Add

Picture. A window appears for you to select a picture. You can also

specify the location of another file. OR,

You can also drag and drop image and audio files onto a slide. For

example, click the audio tab on the left to view audio files.

You can then drag and drop an audio file onto a slide.  OR,

MMS Composer Window

Thumbnails

of image

files Slide

timeline

Image,

Audio, Play

tabs

Slide

preview

Slide period

(seconds)

Working

space
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If you drag an image or audio file onto the blank area of the working

space, a new slide is created to contain the file.

4. Click  New Slide to add a new slide, then follow the same steps for

adding text, pictures, sound, or video.

5. Enter the time period for each slide in the box above the slides.

6. To preview the message, select the  Play tab then click the �Play

button.

7. To save the message in your computer, click  Save and specify a

location.

Sending MMS

To send the finished message, you must first send it to your phone, then send it

to the recipient using your phone. After composing MMS messages, click 

Update to transfer MMS messages to your phone.  A message appears to tell

you if the transfer was successful or unsuccessful. Updated MMS files are sent

to the MMS Drafts folder in your phone.

Notes:

�  MMS messages uploaded to your phone can only be saved in the Saved Items

folder. File Manager cannot be used to upload or download MMS files.

�  Do not use the Handset Manager MMS function while the handset is in the MMS

menu or sending and receiving MMS.
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File Manager
File Manager shows the

files in your handset and in

your computer, and enables

you to move files simply by

dragging and dropping.

The upper columns show

handset files and folders.

Handset folders are on the

left. When you select a

folder, the folder contents

appear on the right.

The lower columns show

computer files and folders.

Computer folders are on the

left.

When you select a folder, the folder contents appear on the right.

Moving a File

To move a file:

1. Select the file location.

2. Select the file destination.

Handset /

Memory

Card folders

Computer

folders

Update / Download icons

File Manager Window
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3. Click the file to select it.

4. Drag and drop the item to the desired location, OR

Click the  Update icon to move to the handset or the  Download

icon to move the file between the phone and the computer.

A message appears to tell you if the transfer was successful or

unsuccessful.

Notes:

�  You need to select the appropriate folder for the file type. For example, if you want

to transfer a video file to the handset, you need to select the Video folder in the

handset. When transferring to the phone, a file transfer will not be completed if

the location does not match the file type.

�  The default folder for Handset Manager files in the computer is in the My Docu-

ments folder: My Documents > Mobile Action > Handset Manager.

�  When dragging and dropping, the  icon means files cannot be dropped to a

destination.

�  When dragging and dropping, the  icon means files can be dropped to a

destination.

�  Large files may take a few minutes to move. To reduce the transfer time, you may

use the handset as a mass storage device instead. Following these steps to use

your handset as a mass storage device:

1. Connect the handset to a USB port on computer using the supplied USB data

cable, then turn on your handset.

2. A list of connection types appears in the handset window. Select Mass Storage.

3. Select My computer>Mass Storage, and select from Audio, Images, Photos,

Video folders to store your file.

�  When installing Java games, download “Java Game.jar” from the Internet to the

handset’s Java installation folder. When the installation is successful, a message

indicates that the installation is successful.
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Video
The Video tool helps

you to view, edit, and

enhance videos. A

storyboard and timeline

allow you to simply

drag-and-drop video

clips, image clips, text

effects, and sound files.

Spice up your videos

with transition effects,

opening clips, image

frames, ending clips,

and voice-over objects.

To preview a video,

press the �Play button

under the preview pane

in the upper left corner. The video then starts to play.

Press the Pause button to pause. Press the �Stop button to Stop.

Downloading Videos to the Computer

To download a video from the phone to the computer:

1. Select a phone location from the drop-down menu. Select Handset or

Video  Window

Video

thumbnails

Preview

pane

Handset /

Memory

Card pane

Icons for functions
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Memory card. The video files in that location then appear.

2. Click an individual video file to select it.

3. Click the  Update icon. An Update dialog box appears. Click OK.

The file is then transferred to the computer.

A message appears to tell you if the transfer was successful or

unsuccessful.
Note:

Videos need to be downloaded to the computer before you can edit them.

Composing and Editing Videos

The Video Composer provides a storyboard and timeline  for simple, intuitive

interface for working with videos.

Video Composer Window

File

thumbnails

Video timeline

Video, Image, Text, Sound tabs

Video slides

Preview Pane

Template buttons
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Videos are composed of one or more slides containing video, images, and

sound. Slides can also contain images only, or contain video with images or

even another video overlaid.

There are also templates to apply frame effects.

If you have a video recording device connected to the computer, you can add a

new video recording by clicking the   Record icon.

To Edit a Video:

1. Click a video file to select it.

2. Click  Edit.

3. The Video Clipper window opens within Video Composer. If you want

to place the entire file into the storyboard, click OK. You can also clip

the video using controls in this window, then click OK.

4. To add another file to the storyboard, click  Add video clip. A dialog

box opens for selecting a video file.

5. Images and audio can be added to slides. To add images or audio to a

slide, select the appropriate tab on the left and drag and drop files, OR

Click the  Add video image / overlay,  Add text effect object, or 

Add sound object icons in the timeline pane.

6. Click  Save to save the video to the computer. You can later upload

the video to the phone from the main Video window.

Note:
The phone supports videos in 3gp and mpeg 4 formats, with dimensions of 176 x 144.

Video files in other formats are automatically converted when they are updated to the

phone.
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Updating Videos to the Handset

To update a video from the computer to the phone:

1. Click an individual video file in the computer to select it.

2. Select a phone file location from the drop-down menu. Select Handset

or Memory Card. The video file will be transferred to the video folder

in the selected location.

3. Click the  Update icon. An Update dialog box appears. Click OK.

The file is then transferred to the handset.

A message appears to tell you if the transfer was successful or

unsuccessful.

Notes:

�  You can select storage devices for Phone or Memory Card in the Video folder

from the left of the window.

�  Right-clicking on the window of the phone and selecting Download is just to allow

this software to read the selected picture file rather than saving it. To save the

picture file, right-click and select Save to save the file in the desired folder.

�  Click the refresh icon  to update the status of the folder

�  The files saved in the phone will be converted to .3pg format automatically.
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Sound
The Sound tool helps you to edit and manage sound files. You can even com-

pose and record your own sounds.

Sound files in the phone appear in the pane to the left, and sound files in the

computer appear in the pane to the right.

Video Composer Window

Play Controls

Folder

contentsPhone Files

Icons for functions
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Downloading Sound Files to the Computer

To download a sound file from the phone to the computer:

1. Select a file in the phone pane.

2. Click the  Download icon, OR

Right click on the file and select Download from the drop-down menu.

Notes:

Sound files in the phone must be downloaded to the computer before you can open

them for viewing or editing.

After editing or composing a sound file, save the file first to the computer in the

Handset Melody folder. Then, from the main Sound tool window, update the file to the

phone as described above.

Playing Sound Files

To play a sound file:

1. Select a folder location to display the folder contents

2. Click the file to select it.

3. Click the � Play button to play. Click � Stop to stop, and � Pause

to pause.

Composing with MIDI Composer

The MIDI Composer interface enables you to compose MIDI tunes by inserting

notes on a music staff. You can create different tracks and assign tracks sounds

from up to 15 musical instruments.
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To compose a new MIDI file:

1. Click   New MIDI. The MIDI composer window opens.

2. To add a note or rest to the music staff, click  Input Note.

3. Select a note or rest value from the icons on the left. For example, for

a quarter note, click .

4. Click a position on the staff to place the note.

5. To add a new track, click   Track Manager. To change the instrument

assigned to the track, click on  Change Instrument.

6. Click  Save to save the file to the handset\audio folder.

Editing and Recording with Audio Composer

To open Audio Composer:

1. From the main audio window, click   New Audio.

2. The Audio Composer window opens.

To edit an audio file,

1. Click an Audio file in the left pane.

2. Drag the file to a track location to edit it.

3. Drag the red line or click on the icons at the top of the window to

perform various editing functions.

4. Click  Save to save the edited file.
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To record a new audio file:

1. Click  Record audio. A recording window opens.

2. From the Sound Recording Device drop-down menu, select a type of

computer audio input to record, such as microphone or CD player.

Consult the user manual for your computer or sound card if you need

more information.

3. Click the  Record audio to begin recording.

After recording, you can edit the track using the various icons in Audio

Composer.

4. Click  Save and Exit to exit and / or save. The file is saved in the

handset/audio folder.

Editing an MP3 File

You can clip or combine MP3 files to use as ringtones using the MP3 Clipper

tool.

To edit clip or combine MP3 files:

1. From the main audio window, click  New MP3 click to open the MP3

Clipper window.

2. Select an MP3 file from the pane on the left.

Double click the MP3 file or drag it onto the timeline to edit it. A visual

sound wave view is then shown on the timeline.

3. Set start and end times for the clip on the timeline.

There are two vertical red lines to drag on the timeline. To set start or

end times, drag a red line to the desired position, then click   Set

start time or  Set end time icons.
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4. Click  Play to hear playback of the selected area.

You can also preview the selected clip by clicking on the Audition tab,

then pressing the �Play button.

5. Click  Save to save the MP3 file.

Notes:

�  The handset must be connected to the computer in order to save an MP3 clip or

update an MP3 clip to the handset.

�  You may save MP3 ringtone files in any location on your computer, though saving

to the assigned Handset Manager folders may be a convenient way to keep files

organized. When you update MP3 files, the files are automatically assigned to the

correct location in your handset.

Updating Audio Files to the Handset

To update a sound file from the computer to the phone:

1. Select a file in the computer pane.

2. Select the desired destination, Handset or Memory Card in the phone

pane.

3. Click the   Update icon. Sound files are stored in the Audio folder of

the handset or memory card. Within the Audio folder, there is also an

MP3 folder for MP3 files.



41

H
 a n d s e t   M

 a n a g e r
SyncManager

SyncManager enables you to synchronize the contacts  and calendar in Out-

look/Outlook Express and your handset.

You can also transfer contact information using the Phonebook tool of the

Handset Manager. If you need to specify which fields to transfer, you should

use the Phonebook tool. The SyncManager, however, enable you to quickly and

conveniently exchange data between your phone and your computer. The

SyncManager is also tailor-made for people who need to regularly or frequently

exchange data.

Note:

You can also exchange information between the phone and a Palm Pilot by connecting

the Palm Pilot to your computer.

SyncManager Window

One-step or

Manual

synchronization

Items to

Synchronize

SyncManager

Settings
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Starting the SyncManager

To start SyncManager:

Connect your handset to the computer. Follow Step 1 and 2 as described in

page 7. To install the Handset Manager software: Select Asus V66 USB—

Handset Manager> SyncManager from the computer’s programs list, OR

When Handset Manager is minimized to the system tray, right-click on the

Handset Manager icon and choose SyncManager.

Note:

Before using Sync Manger, you must install Microsoft Outlook/Outlook Express first.

Synchronization

You may choose to synchronize your Contacts, Calendar, or both between your

handset and computer. Check the items you wish to synchronize before starting

synchronization.

� Click One-Step and synchronization of phonebook contacts and

calendar begins right away. All the items in contacts or the calendar

are synchronized.

� Click Manual to individually select the entries or items in contacts or

the calendar you want to synchronize.
      � Choose to synchronize Contacts/Calender with Outlook or Outlook Express.

      � Click Select Folder... to choose a folder that contains Contacts items to

                    synchronize with.

When you select Manual, a window appears displaying contacts and calendar
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data.  Select the check mark boxes to select entries to synchronize. Outlook

entries are shown in the left column. The middle column shows handset entries.

The following symbols indicate the status of each item:

 Item synchronized in Outlook and handset.

(Gray arrow). Item is not selected.

 (Green arrow). Item will be deleted or written to the handset, as indicated in

the remarks column.

 (Red arrow). Item will be deleted or written to Outlook, as indicated in the
remarks column.

Manual Synchronization Window

Outlook

Entries

Handset

Entries

RemarksStatus

symbol



44

®

Conflicts are also shown in Manual view. Conflicts occur when it is unclear

whether the phone or the computer has the most recent information for an

entry. The SyncManager gives you  options for managing conflicts in

SyncManager Settings.

Starting Synchronization

To start synchronization:

1. Check the items you wish to synchronize and uncheck other items.

2. Click Next to continue.

3. You are asked to confirm updates. Select OK.

Notes:

�  Synchronization will change the information stored in Outlook/Outlook Express and

handset. Any changes in the handset will also affect the information in your

Outlook/Outlook Express. If you want to update the  information to the handset

without changing the information stored in your Outlook/Outlook Express, please

uncheck the box before Outlook entries and proceed with synchronization.

�  Some fields in handset entries might be slightly different with those in the Outlook

entries. You may use the Manual  Synchronization to specify the fields.

�  Due to the word limit for handset entries, the SyncManager will eliminate the

excess words from Outlook entries automatically.

SyncManager Settings

You may find it convenient to set your preferences in the SyncManager settings.

SyncManager will remember your preferences each time you synchronize.

For example, if you  plan to synchronize weekly, and synchronize the calendar,

but not phonebook contacts, then you can enter these settings into
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SyncManager settings once, then click on the One-Step button to automatically

synchronize thereafter.

In the SyncManager settings, you can set the kind of synchronization you would

like to do, manage folder details, calendar settings, and manage conflicts.

To open the settings window, click on the Settings button in the main

SyncManager window, OR

Select  Asus V66-USB Handset Manager >SyncManager Settings from the

Windows Start Menu.

The Settings window contains three tabs: Settings, Contacts, and Calendar.

� In the Settings view, you can select the items you would like to

synchronize. Under Sync Items, check Contacts or Calendar. The next

time you open SyncManager, these items will be selected.

You can set general options, including how often to synchronize data,

and whether to start synchronization automatically or manually.

Under Conflict Resolution, you can set the action to take when a

conflict occurs: Skip this item, Computer overwrite handset, or Hand-

set overwrite computer.

� In the Contacts view, choose to synchronize Contacts with Outlook

Express or Outlook. You can also select the contacts folder to syn-

chronize with.

� In the Calendar view, select beginning and ending dates for the

Calendar synchronization period. You can also select the calendar

folder to synchronize with.
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Wireless Modem Installation
Your handset can be used as a wireless modem.

1. Install the wireless modem feature from the Handset Manager CD.

Click the Setup Wireless Modem button to begin the installation.

2. You select whether to configure your

wireless modem as a GSM device, or a

GPRS device. If you select GPRS, you

must also configure an Access Point

Name (APN), Quality of Service (QoS),

and Domain Name Server (DNS

settings. Please contact your system

provider for the required information.

3. Complete all the required fields and click

the Next button to continue.

4. Enter a name for the connection and a

telephone number.

5. Click the finish button to complete the

installation. You may have to reboot your

computer before the wireless modem

facility works properly.
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